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Activities Book — Logging Activity in FranConnect

In order to keep leads moving through the pipeline, and allow the whole team to see
the history of a lead and the associated deals, you need to adopt the attitude that “if
it's not in FranConnect, it didn’'t happen” and log EVERYTHING.

Fortunately this is easy with the many ways that FranConnect lets you communicate
directly from inside the Sales module, and incorporate the tools you use every day,
such as your mail app and your phone, to seamlessly keep track of the effort that
you’'re putting in to close that partnership!
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Managing Leads in FranConnect

Sending Email to a Lead

Email messages are often an essential tool in the dialog between a lead and members
of the sales team. The email editor can be used to write ad-hoc as well as template
based messages.

There are three places from which to send an email:
Select Send Email from the Lead record.
Select Send Email from the action wheel on the Lead Management page.
If sending an email to multiple leads,
a) Select the leads from the Lead Management page.
b) Click the green action button.
¢) Click Send Email.

To send email to a lead from FranConnect:

1. Select Send Email from one of the locations listed above.

2. Choose a From/Reply option:

1. Logged User ID: Your user ID.

2. Lead Owner ID: The Sales person responsible for the lead.

3. Custom: Enter in an email address for the recipient.

4. If you want to use a template you've already created, choose the template
from the Email Template dropdown.

5. The To field will populate with the lead name.

6. If relevant, enter an additional contact in the CC field. Additional contacts can

be searched and added using AddressBook.

7. Input a Subject.

8. Tosend this email to the Co-Applicant as well, Select the check box to Send
Email to Co-Applicants.

9. Toadd your signature, Click Add Signature (see [Creating a Signature).

10. Input your text into the Email editor.

11. Click Send.



Logging a Task for a Lead

The task form for Franchise Sales provides options for logging and assigning a task to
various members of your franchise sales team.

Tasks added appear in the following locations:

® |n the Contact History section on the Primary Info tab in the Lead record
® On the Calendar page of the assignee
® On the Tasks page

There are four places from which to Log a Task:
Select Log a Task from the Lead record.
Select Log a Task from the action wheel on the Lead Management page.
From the dialog box resulting in the completion of logging a call.
If logging a call for multiple leads,

1. Select the leads from the Lead Management page.
2. Click the green actions button.
3. Click Log a Task.

Tolog a Task:

1. From the Primary Info tab of the lead recors (Contact History section), the calendar
page of the task assignee, or the Tasks page: select Log a Task.

2. Select one of the following options in the Assign To field to assign the task:
Lead Owner: The sales person responsible for the lead.
Other User: Assign the task to another user of the FranConnect
system. The schedule for this user can be viewed in the table at
the bottom of the page.

3. Select a Status from the drop-down.

4. Select a Task Type from the drop-down.

5. Input a Subject.

6. Select the checkbox for Timeless task to place the task in the task list
without a scheduled date or time.

7. Choose a Priority from the dropdown.



10.

11.

12.

13.

14.

15.

16.

Input a Start Date.
Click the checkbox for Add to Calendar if you want the task to show on the
Calendar page (if you want this task to appear on your Outlook Calendar, see
[Using Outlook Integrations).
Select the Start Time and End Time.
Input Comments.
Select a reminder option from Set Reminder.
e No Reminder: No system reminder will pop-up.
e 15 Minutes Prior: A pop-up will appear 15 minutes prior to the Start
Time.

e Set Time Yourself: A pop-up will appear at the time you set.

Click the checkbox for Task Email Reminder to send an email to yourself at
the time selected in item #12.

If you choose to set the time yourself, you will be required to fill in the
Reminder Date and Reminder Time.

Click Create

Click Create and Create Another to add more tasks.



Logging a Call to a Lead

There are three places from which to Log a Call:

e Select Log a Call from the Lead record.
e Select Log a Call from the action wheel on the Lead Management page.
e If logging a call for multiple leads,

a. Select the leads from the Lead Management page.

b. Click the green action button.
c. Click Log a Call.

To Log a Call:
1. Select Log a Call from one of the locations listed above.
2. Input the call Subject.
3. The date and time will pre-populate with the present date and time (to the
most recent quarter hour).
4. Select a Call Status from the drop-down.
5. Select a Communication Type from the drop-down.
6. Enter text in the Comment box.
7. Click Add. A dialog box will appear asking you to confirm scheduling a task.
8. Click Yes to Log a Task. Click No to return to the origination page.



Adding Remarks to a Lead Record

The Remarks form is useful for logging information or actions that don't fit the Call or
Task format. Remarks are date and author stamped when submitted. Remarks are
displayed in the Activity History section of the lead record.

To Add a Remark

1. Select Add Remarks from the top navigation bar of the lead record, or the
action wheel for the record on the Lead Management page.

2. Input notes into the text box.

3. Click Submit.

Adding Sales Tasks

You can associate a Task with a Lead by following the steps mentioned below:

1. Select Tasks from the Sales module.
2. Click Add Task.
3. The following Associate Lead with Task screen appears:



Copying FranConnect on email communications

Using a feature called Email Capture, you can include FranConnect on emails that
you send to your leads, by cc:ing or bceing a designated FranConnect email address.
You need to configure that address, then make sure that members of the sales staff
who will use it know what the email ID is.

For any email with the FranConnect email in the cc or bcce line, the email will be
attached to any leads in FranConnect, based on matching email addresses. If any
email ID does not match with the email ID of any record in FranConnect then that
email will not get uploaded. The uploaded email will be available under the Message
History of the record.

This is a 60-minute period-based activity, so the email should appear in the history
record within an hour of the email being sent.

Configuring Email Capture

To configure the Email Capture in FranConnect Sky:

1. Navigate to Admin > Sales > Configure Email Capture

2. Enter the POP server information, and create an email alias that will be used
to receive emails, as well as a password for that alias. A typical email address
would be yourcompany@franconnect.com.

Q [fype and press en D) QO
iles > Configure Email Capture

CONFIGURE EMAIL CAPTURE

@j Note :

This section allows to Configure Email server and Email information.
User needs to use this Email in To, Cc or Bce, while sending Emails to Lead(s), so that System will capture Emails from this Email account
automatically and display in respective Lead's Message History Section.

*POP Server

*Email

*Confirm Password
[soe J e n .

Once the configuration is done, the integration is ready to use. Distribute the email
address for your staff to use when emailing leads.

If you'd like to have an easy way to copy FranConnect without having to remember
the email address each time, see “setting up a template” for the email system you
use.



Setting up a Template to automatically BCC FranConnect from Outlook

dialog box.

File Home Send / Receive Folder View
LS Repl|
=R B WO e
New New | o Delete Archive Reply Al .
Email Items | ® > Forward M
New Delete Respond
4 Favorites N

2. Choose the drop-down arrow at the bottom right of this dialog, and choose

New Quick Step > Custom.
B 8ccC SF
E]Officeplide

Tags
— To Manager jOneNote *
& Team Email N
v Done

(‘) Reply & Delete

+,/’ Create New

jRules ~

Add-ins Help

[ BCC SF
[V OfficePride
— To Manager

Quick Steps

]Move ~ fo

Search Sent Items

Flag & Move...
New E-mail To...
Forward To...

New Meeting...

Custom...

Sent Iltems - sherry.stanton@franconnect.com - Outlook

Q Tell me what you want to do

In the Outlook Home toolbar, in the QuickSteps section, find the QuickSteps

EMove + f A8 New Group Search People A) E
P A8 Browse Groups | [B] Address Book
= Tags 7 Fier Email Speech
[BoneNote er Emal v Ac
Move Groups Find A
['search sent tems O Tcurrentroider ~|  (2Reply €

Move to Folder...

- Categorize & Move...

3. Name your Quickstep - for example "BCC FranConnect", and choose the

action New message.

Edit Quick Step

Marme:
BOC Salesfrree 2

Add acilons bebow it will be performed sshen his quick step s dicked on

Choase an Adion

vith attachment

ith text of meszage




4. A dialog will open with a field for who this email is to be sent to. Choose to
Show Options, and choose Add BCC.

Hame:
E BCC Salesforce 2

Add actions bedow that will be performed when this quick step is dicked on.

INew Message

Ta..
add ¢
Subject
Blag No Hag -
mportance: No Change v
Text
[ autamatically send after 1 minute delay.
Add Action

Shorteut key:  Choose a shortcut »
I0OMIP WXt This text will show up when the mouse havers over the gquick step

e
5. Paste in the FranConnect BCC address, and if you like, choose to assign a
shortcut key. Put a brief description of what this Quickstep does in the text,
such as "sends a blind copy to FranConnect". Press Finish.

6. Now the Quicksteps section of your Home Ribbon in Outlook will include the
option to send a mail with BCC to FranConnect. Click on the Quickstep, or
use your shortcut key combination to open an email with the FranConnect
BCC already included.

Setting up a Template to automatically BCC FranConnect from Gmail

Q Search all conversations

Settings

| Labels Inbox Accountsandimport Filters and Blocked Addresses Forwarding and POPIMAP Add-ons  Chat and Meetf( Advanced

Auto-advance
Show the next conversation instead of your inbax after you delete, archive or mute a conversation. You can select Enable * Disable j

whether 1o advance to the next of previous conversation in the "General” Settings page

Templates
Turn frequent messages into templates to save time. Templates can be created and inserted through the "More ® Enable Disable

options” menu in the compose foolbar. You can also create automatic replies using templates and fiters together

Custom keyboard shortcuts
Enable the ability to customize your keyboard shortcuts via a new settings tab from which you can remap keys to Enable * Disable

various actions. ‘

10



Q  Search all conversations

Bec: franconnect@yourcompany.com

Enter a new template name

bee FranConnect

Default to full screen
= Quote pem
ny Cancel Sove NSERT TEMPLATE Templates » N
S &0 Label
y 1 LY
> important Plain text mo
T o
£~ Sent 3 [ save draft as template » ™
3 Print
) o Y S elete template » Ban
Check spelling
' Catt . .
g o Save as new template I
" oA Smart Compose feedback
- m

+ Rooms*# + Bam
R [ e [ @ B

Q_  search all conversations

Default to full screen

" apiar Templates » |
Label
arm
Plain text mode’
| [ savedraft as template ’ | 79
Print
Delete template 2rm
Check spelling
. “am

Smart Compose feedback

EN::sosun”

i 3am

|- - e o- 2 fu

Gmail Integration

Enabling the Gmail Integration App

To download the Gmail Integration App, log into FranConnect, and from your user ID
at the upper right drop-down of the screen, and choose Options. In the Options page,
choose the Download Apps tab.

Q Type ana press enter Recent Soved Sercnes 0 & @ o
sea

Navigate to the Gmail App. Click on the button that says, “available in the chrome
web store” to download the app.

Note: Make a note of the Company Code (highlighted in red below), which is one
element you’ll need to sign into the FranConnect Gmail plugin.

11



FRANCONNECT SKY FOR GMAIL
™1 GMAIL CHROME PLUGIN

FC FranConnect Where You Work! More and more, businesses are turning to the G Sulte to support their emall and document management needs. With FranConnect Sky for Gmail, you will be
ky able to interact with your leads, franchisees, and contacts from your FranConnect Sky system right from within your Gmail inbox.
« Real-time tracking of prospect and customer interactions
Gmail
M * Automatically enrich c

To configure FranConnect Sky for Gmall for the first time, enter your FranConnect Application credentials (Login 1D, Password and Company C§e salesdemosetrgldemoDin their respective
fieids.

>
Qo

In the chrome web store, find FranConnect for GMAIL and choose the Add to Chrome
pbutton.

£~ chrome web store @ sstanton1c02@gm

Home > Extensions > FranConnect Sky for Gmail

FC FranConnect Sky for Gmail

Gmail

Offered by: FranConnect LLC

ok ok 2 ‘ Productivity | 2 388 users

Choose to “Add extension” from the resulting dialog.

F(C  Add “FranConnect Sky for Gmail"?

Gl

[t can:

Read and change your data on apifranconnect.com, mail.google.com, and
WWW.google.com

Add extension

R S o B ] | .
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Once the App is downloaded, a confirmation message will be displayed.

>
FG FranConnect Sky for Gmail has been added to

Gmaill™ Chrome
Use this extension by clicking on this icon,

Manage your extensions by clicking Extensions in the Tools

mMenu.

Log into Gmail. To the right, there will be a panel for FranConnect. Enter your
FranConnect user name, password, and Company Code from the Download Apps
screen.

Search ol comversations

Fr‘anConr&ect‘
sky

INSTRUCTIONS &
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Using Gmail with the FranConnect plug-in

While running the FranConnect Gmail app, when you highlight an email address, the
App will suggest records in FranConnect that match the email address. It will also
suggest related contacts based on the domain name in your email. These records
may come from the Sales, Info Mgr, or CRM modules.

€« C | @ Secure | https//mail.google.com ® Y
Google == # 0@
Gmail - . c More ~ 123023 = - Q-

m Matt D.-@ Question about franchise opportunity - Test tra Matt Dwyer VF 1015 am
Fr‘anConri(ect‘
N ")
Inbox (5) Matt Dwye "“?“ Dwyer RN . Nk sky

Starred Sam Oredl . SER | VP of K ige Manage Apr3 Q = o)

a8
£3
o Shanna Jo o ' "4 hanks! Shann Mar 16 matthew dwyer@franconn X
o labels > - Vo i LN Mar 16 Docusign Test
matihew dwysr@tranconnectcor
kyle voniderstein FranConnect Inquiry - Interested in Fr e e Feb28 Sales Lead >
Mike +
0
Mike Morper Deck link - hitg esync serverdal, t EE bKhntyNND4/ Jan 30 m Matt Dwyer
matthew. dwyer@franconnectcor
'] Lea -
Mike Morper FDD question - This is the bod Jan29
Matt er
Matt Dvyer FDD Review - present Nick Canu as you k oty 1 Jan 29 m ety b S
ales Lead
Nick Mecozzi Next Steps - Hi Ben, I'm intrigued by our previo ersations about i Jan 28
o Richard Michaels
Nick Mecozzi Discovery Day - Hi Ben. I'm very excited about the opportunit k Jan 28 r@Mranconnect com
N
Nick Mecozzi Financing Options - Hi Be tod 1o reach out 1 you know that Ive sta Jan 28
Mike Morper Financing for Denver - My partners ar 4 like 1o iscuss with you first right Jan 28
Mike Morper Technology assistance for my units - | noticed in the FDD that you provide tech ¢ Jan 28

|

Note: To regain screen space while running the app, click the right arrow next to your
company’s logo, and the app will minimize to the right of the screen. Click the left
arrow on the same stripe to maximize the app again.

Google = # 0@

[¢] More - 1-230f 23 = - a-
pr— Matt Dwyer Question about franchise opportunity - Test message for trair gement Office: 7 10:15 am
Inbox (5) Matt Dwyer FW: 0.1.8 Pushed out - Matt 4 {J thew dwyer@ Aprd
Starred S D Test emall - This Is a test email — SAM DRESSER | VP of Knowledge Management and Engagement 529 Pennsylvan Apr3
Sent Mail
Shanna Johnson Email from Shanna - Hi Mike, Per your request, here is an email Thanks! Shanna Mar 16
Drafts
Mike Morper New property - Thi sample ema Mar 16
More labels ~
Kyl t F 1 Inquiry - Interested in Franchise Sale e Feb28
™ = yle voniderstein ranConnect Inquin
-
Mike Morper Deck link - hitg sharesync serverdata net/u RE E Bthf6bKhntyNND4! Jan 30
Mike Morper FDD question - This is the bod: Jan 29
Matt Dwyer FDD Review - Benjamin, | represent Nick Caruso, who as you know is currently reviewing your FDD. After reviewing your disc Jan 29
Nick Mecozzi Next Steps - Hi Ben, I'm intrigued by our pre nversations about the franchise opportunity and wanted to set up a meet Jan 28
Nick Mecozzi Discovery Day - Hi Ben. 'm very excited about the opportunity and look forward to the next step. Please send me some logi Jan 28
at
e Nick Mecozzi Financing Options - Hi Ber anted to reach out and let you know that I've started down the road with exploring various fin Jan 28
Mike Morper Financing for Denver - My partners and | would like to & th you first right of refusal on the Denver market. We're preg Jan 28
o . Mike Morper Technology assistance for my units ed in the FDD that you provide tech servi eally need a CRM application that Jan 28
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Click on an email to open it. Part of the email is a button to add the email to a
FranConnect contact. Select the contacts in the FranConnect panel by clicking on the
slider panels next to their names, and adding any additional names and selecting
them with their slider panels.

Google [ Q| z 0@

Gmail + - ] ° ] - % More « 10023 > = - Q-
COMPOSE Question about franchise opportunity weex & B P .
PPoTtTRY, Fr‘anConr&zct
Inbox (5) sky
9 Matt Dwyer <matthew dwyer@franconned ¢ 10:15 AM (1 hour ago) - - Matt Dwyer
Starred ! ike k matthew dwyer@fran Q ;.. o
Sent Mail FC  Add email to FranConnect =
= Show detais Select the contacts you wish to
Pty T DRRenge fOF NaNg! associate with this email
More labels ~ Docusign Test
matthew.dwyer@franconne...
ane + Sales
M dh ect cor Rick Marsh
FranConnect Sales
e e L0 S
[N
New people to add to FranConnect
-
me £
ben.fc.seller@gmail.com
Start a new one Vikram
0GB (0%) of 16 GB used Torms - Privac vikram.raj@franconnect.com
Manage Last account actirty: 49 minutes 390
Detats
UPLOAD EMAIL
B Include attachments

Then click the Add email to FranConnect.

Note: The first time you add records to FranConnect from this app, you'll be prompted
to give FranConnect permission to access Gmail records. Press Allow to give
FranConnect permission to Gmail messages.

G Request for Permission - Google Chrome - m} X
&

Secure | https://accounts.google.com

GO g|€ ben fc_seller@gmail.com ~

~ FranConnect Sky for Gmail Extension would like to:

M View your emails messages and settings

View your email address

View your basic profile info

By cicking Allow, you allow this app and Google to use your information in
accordance with the respective terms of service and privacy policies. You can
change this and other Account Permissions at any time

Deny Alrw
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Locating a FranConnect contact from a Gmail message address

While running the FranConnect Gmail app, when you highlight an email address, the
App will suggest records in FranConnect that match the email address. It will also
suggest related contacts based on the domain name in your email. These records
may come from the Sales, Info Mgr, or CRM modules.

CISNCI @ seaxs | htps/mallgooplecon ®% % :
Google [Eaa # 0@
smail ~ C More 1-230f23 = - o]
Matt Dw Question about franchise opportunity age for t Mat VP 1015am
COMPO SE .
o] i Fr‘anConriEct
Inbox (5) Matt Duye ot DWYE v Manage Aprd sky
Stamed Sam Drest . " p " Ape3 Q as o
=
. Shanna Jo c 1 . Mar 16 matthew dwyer@franconn X
ke | B = Mar 16
e labels ~ Mike Morp - b Mor 1 0 Docusign Test
- kyle voniderstein FranConnect Inquiry - Inte a . Feb 28 Sales Lead >
Mike +
*
Mike Morper Deck link - 1 y " t ! h K NN Jan 30 m Matt Dwyer
ales Lead o
Mike Morper FDD question . Jan 29
Matt Dwyer FDD Review opresent Nick v Jan 29 0 e
Sales Lead
Nick Mecozzi Next Steps - Hi Be ’ y . bout ] Jan 28
Richard Michaels
Nick Mecozzi Discovery Day - H Jan 28 mathew dwyer@tanconnect com
Nick Mecozzi Financing Options fed 10 reach out know that Jan 28
Mike Morper Financing for Denver - My part 1 Jan 28
2 9 Mike Morper Technology assistance for my units - | noticed in the FDD that you provide tech Jan 28 NEW

You may choose to associate this email with an existing contact record that has no
email relationship to the email address in the record. To search for that record, type
the email address of the FranConnect contact in the search field and click the
magnifying class icon to search for the record.
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Adding a FranConnect contact from a Gmail message address

If there are email addresses on the thread that do not have matching email
addresses in FranConnect (but are from the same domain), those email addresses
will be listed at the bottom of the list of possible FranConnect records to associate
with the email. You can choose the New button next to any of them to add a record to

Sales, Info Mgr or CRM.

Click New next to a listed name, or New from the button at the bottom of the list. You’ll
be prompted to choose which data set to add the contact to — Sales or CRM lead, or Info
manager or CRM contact. Then you’ll fill out any information remaining, e.g. the Source

information for a lead, and click Save.

Fr‘anContisct'
sky

Q an o

Select the contacts you wish to
associate with this email

Docusign Test
matthew.dwyer@franconne... )
Sales

Rick Marsh

mike.morper@franconnect.... ‘
Sales

New people to add to FranConnect
me
ben.fc.seller@gmail.com

Vikram
vikram.raj@franconnect.com

NEW

NEW

UPLOAD EMAIL

Fr‘anCcnnri(ect'
sky

Q ah =
Select Source Category

0]

Select Source Detail -

Emai

Matthew.dwyer@franconnect com|

-
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Saving an email to a FranConnect contact

Click on an email to open it. Part of the email is a button to add the email to a
FranConnect contact. Select the contacts in the FranConnect panel by clicking on the
slider panels next to their names, and adding any additional names and selecting

them with their slider panels.

Google | a |

Gmail ~ - ] o [ | B 9 - More
m Question about franchise opportunity msex x ]

Inbox (%) 7 Matt Dwyer amatthew duyer@franconnect 1015 AM (1 hour ago| .- - Matt Dwyer
Starred ik k N~ ’
Sent Mail C  Add email to FranConnect =

Drafts Test message for training!

More labels ~ Matt Dwyer

VP, Product Management

Mike - O L
y 15

FranConnect
e —— ] ()

0GB (0%) of 15 GB used Torms - Privacy
Last account actity 49 minutes ag:

Show detais

°c0

of 23 > = -~ o]
FranConnect’
“sky
Q an o

Select the contacts you wish to
associate with this email

Docusign Test

Sales

Rick Marsh
Sales

New people to add to FranConnect

e NEW
ben.fc.seller@gmail.com

Vikram
e NEW
vikram.raj@franconnect.com

UPLOAD EMAIL

B

Then click the Add email to FranConnect in the message, orUpload Email in the

FranConnect app panel.
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Outlook System Integration

For System Administrators that are supporting organizations using Exchange Server
2013 or Exchange Server 2016, please refer to the following MicroSoft TechNet
notices about deploying Outlook add-ins

Installing and removing Outlook add-ins

Managing Outlook add-in user access

Accessing & Configuring the Outlook Add-in — for Windows

Select the “Store” icon (If “Store” does not appear, enable “Show Tabs and
Commands”).

Search on “franconnect” to find and enable the add-in.

X

Add-Ins Connectors
Add-ins may access persanal information. By turning an add-in on, you agres 1o its License Terms and Privacy Policy
Click here to add & custom add-in
e N
~—
Category F(  FranConnect Sky for Outlook
Al sky Access your leads, franchisees, and contacts without leaving Microsoft Outlook

Successfully added ¥ Get started
My add-ins

19


https://technet.microsoft.com/en-us/library/jj943752(v%3dexchg.150).aspx?f=255&MSPPError=-2147217396
https://technet.microsoft.com/en-us/library/jj943757(v%3dexchg.150).aspx

Select “Continue” to enable the add-in.

Send / Receive Folder View

Inbox - doug.smith@franconnect.com - Outlook

Q Tell me what you want to do

D XE QR Qe

3@ Delete Archive

Delete

New New Reply Reply Forward [«
Email ltems - Al

New Respond

Search Current Mailbox Current Mailbox +

All Unread Mentions
4 Monday

el

Newest L

Inbox 12

FranSocial

Fransocial Forum Digest for Fri
2 new threads and 1 reply from 3
authars in the “Fransocial Forum®

. Mon 10:06 ...

£
£
E
Z
A

Last Week

FranSocial

Fransocial Forum Digest for Mo...
1 new thread and 2 replies from 3
authars in the “Fransocial Forum

Tue 11/7

FranSocial

Franchise Relations Dialogue for...
1 reply fram 1 author in the
“Franchise Relations Dialogue”

Tue 11/7

FranSocial

Fransocial Forum Digest for Frid...
3 new threads and 2 replies fram 3
authars in the “Fransocial Forum®

Mon 11/6

FranSocial

Franchise Relations Dialogue for...
1 reply from 1 author in the
“Franchise Relations Dialogue”

Mon 11/6

4 Two Weeks Ago

b~ IT & infrastr... ¥ Move -
& To Manager

1 Team Email

ﬂ ) Unread/ Read

B Categorize -

‘o Rules -
7| HMioneMote Po‘,cy, [> Follow Up -
1] Move

Quick Steps Tags

C2Reply B2 Reply All 3 Forward

FranSocial <DoNotRe a81-  Mon 10:06 AM
Fransocial Forum Digest for Friday Nove...

@ 17 there are problems with how this message is displayed, click
here to view it in a web browser.
Click here to download pictures. To help protect your privacy,
Outlook prevented automatic download of some pictures in this _,

Fransocial Forum
Post New Message

Nov 10, 2017 - Nov 12, 2017

started 22 hours ego, Grepory Gook (0 replies)

WEBINAR: 4 BRAND COMPLIANCE SECRETS

HOSTED BY LISTEN360
1. WEBINAR: 4 BRAND COMPLIANCE
SECRETS HOSTED BY... Gregory Cook
started 22 hours ago, Robin Gsgnon (0 replies)

IFA Women's Franchise Network Atlanta
Chapter Contributes Time & Monev to Atlanta

% New Group Search People FC
= g
£ Browse Groups =} Address Book
Store Open
Y Filter Email - FranConnect
Groups Find Add-ins  FranConnedt A~
FranConnect Sky - X
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FranConnect Where You Work...now for Microsoft Outlook! With
FranConnect Sky for Outlook, you will be able to interact with your leads,
franchisees, and contacts from your FranConnect Sky system right from
within your Outlock inbox. You will have access to:

Real-time tracking of prospect and customer interactions
Automatically enrich contact information based on email address
Ensures all employees keep system of record current with latest
sales efforts

Easily create contacts and leads directly from within your email
client

INSTRUCTIONS

Powered By
FranConnect

Fill in Login ID, password, and company code fields and then select “Login” (For
details on how to find your company code, please refer to the note in Help Center.)
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http://knowledge.franconnect.com/help/kb/server/franconnectsky/projects_responsive/FranConnect%20Sky/Finding_your_Company_Code_to_log_into_external_Apps.htm?rhhlterm=finding%20company%20code&rhsyns=

A temporary green “Login Success” banner will appear and you can now begin using
the FranConnect Sky for Microsoft Outlook add-in.
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Accessing & Configuring the Outlook Add-in — for Mac

Select the “Store” icon (If “Store” does not appear, select View > Ribbon)
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Search on “franconnect” to find and enable the add-in

Office Add-ins
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Add-ins may access personal information. By turning an add-in on, you agree to its License Terms and Privacy Policy.
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Select “Continue” to enable the add-in.

box « FranConnect
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FranConnect Where You Work...now for
Microsoft Outleck! With FranConnect Sky for
Outlook, you will be able to interact with
your leads, franchisees, and contacts from
your FranConnect Sky system right from
within your Outlook inbox. You will have
access to:

® Real-time tracking of prospect and
customer interactions

Automatically enrich contact
information based on email address
Ensures all employees keep system of
record current with latest sales efforts
Easily create contacts and leads
directly from within your email client

INSTRUCTIONS

Powered By
FranConnect’

Fill in Login ID, password, and company code fields and then select “Login” (For
details on how to find your company code, please refer to the note in Help Center.)
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http://knowledge.franconnect.com/help/kb/server/franconnectsky/projects_responsive/FranConnect%20Sky/Finding_your_Company_Code_to_log_into_external_Apps.htm?rhhlterm=finding%20company%20code&rhsyns=

A temporary green “Login Success” banner will appear and you can
the FranConnect Sky for Microsoft Outlook add-in.
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About FranConnect Mobile Apps

Mobile apps allow you to bring the power of FranConnect wherever you go. You can
log calls to sales leads, check on lead progress, mark opener checklist items
complete, access documents, take training and more.
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Getting FranConnect Sky Mobile App

The FranConnect mobile app can be downloaded on your cell phone or tablet. Users
can upload the visits to the server from their device when they come online.

To download and configure FranConnect Sky App for the first time, navigate to your
designated App Store (Android or Apple), download the FC Field Ops App.

& apps.apple oy

Google Play Apple App Store

& playgogle comistore appa/d

ogle Play Search

. ae d
- App Store Preview
alegares v e charts New reiease

FranConnect Sky Fm"uctn:m sky
L e

_ 1| s = sky
= n?franconnect Q. Type and press enter o o o

Search

Options > Download Apps

Change Password = Change Profile Info ~ Marketing Activity Email | Configure Module Startup = Quick Links| Options

@ ‘

Logout

=n
80

FRANCONNECT SKY
10S /1§ ANDROID

Franchise brands the world over depend upon FranConnect Sky as their system of record for selling, opening, educating and managing the
operations of complete franchise systems. What's more, franchisees also depend upon FranConnect Sky to help them sell products and
services, manage their customers, educate workforces and market to potential customers too. With FranConnect Sky Mobile, the complete
franchising lifecycle is extended to your mobile device, giving you immediate access to the information you need to continue the growth of your
franchise system.

To configure FranCannect Sky App for the first time, enter your FranConnect Sky eredentials (Lagin ID, Password and Company Code
ginger ini ) in their respective fields

[ Ar.)p.storé P Google Play

FRANCONNECT CRM
10S /' ANDROID

"
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Logging In to the FranConnect Sky Mobile App

Log in to FranConnect to find your Company Code, a necessary part of your login. To
find your company code, go to your login ID, choose Options from the drop-down
menu, and choose Download Apps. The resulting screen will display your company
code (highlighted in the screen shot that follows).

= Qrmomes o : oo [@—]
Opti

Download Apps

[T | g— |  Option: s

Change Profile Info  Marketing Activity Email | Configure Module Startup | Quick Links|

@ ) &

FRANCONNECT SKY
105 /1§ ANDROID

f
f
To cor
[

€

your FranConnect Sky credentials (Login D, Password and Company Code

FRANCONNECT CRM
10 /1§ ANDROID

Open the FranConnect Sky app, and enter your company code, and press Continue.
Use your regular FranConnect login ID to login on the screen that follows If your
phone has the option for fingerprint login, you can set this up on your phone as well,
at any time, by following the prompts on your phone.

How to find Company Code
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On following occasions when you open the application, you’ll be able to log in with
your touch ID or with your FranConnect login ID.

6o VO 4 <n® - N

FranConnect
sri(y

signin

Please authenticate to proceed

o

Place your finger on touch sensor
10 continue

Unlock with Touch 1D

CANCEL

Unlock with Login ID

‘? franconnect

< o 1}

To work with leads in FranConnect Mobile, from the hamburger menu at the top left,
choose Sales > Lead Management.

Bo VO i< -

‘ = | Activity Stream

Henryzee Franconnectzee
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B e s
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Settings
4 ] I < o] 1l < @] 1l
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Logging a Call to a Lead

From the Lead Summary Screen, you can use the Magnifier icon to search for text to
find your lead. When you’ve found the record, you can find information (the gray I) or
dial them directly with the phone icon.
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When your call is complete, choose to “log a call from the lead record. The lead
information and call time information and type will be pre-filled. You can then to to
the Notes section and choose to type in a summary, or choose the microphone option
on your keyboard to dictate the summary by voice.

220 o VO 4 <0 ® - KT a19% )21 e VO 4 <n@ - P LT eI
€ Logacall € Logacall « Logacall
Call Details
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< (e} ] v @] 1 5 v @] il i
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Sending Email to a Lead

You can send an email or SMS message directly to a lead from the FranConnect App.
From the lead record, choose “email” (or SMS), and a dialog will open for you to send
the message in the way you always do. The transaction will be recorded as though
you had sent the message from the desktop application.
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